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Installation of the eDocker TOOLS -InDesign extension

1: Copy the eDockerPublisher.zxp file onto your desktop
2: Double click the file, after which the Adobe Exchange Manager program should start up.
3: The program will ask you to accept its terms and conditions and may also give other 
notifications, answer Yes to all of these.

PLEASE NOTE: 
Currently, the extension only functions with InDesign CS6 and CC.
Adobe Exchange Manager must be installed on your computer before you can install the 
extension.
PLEASE NOTE: Use the Exchange Manager that corresponds to your InDesign version.
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Installation
eDocker CREATE! installation

1: Copy the edocker_publisher_2.0.air file onto your desktop or to another convenient 
location.
2: Double click on the file and follow the instructions.
3: When opening, the program will ask you to activate the license. In order to do so, 
you will need the serial number you have received by email (you can use the pro-
gram for a week without activating it).
4: When the program opens, you must import at least one publication, before you 
can do anything further with the program (see page XX).

eDocker CREATE! activation

Activation
1.	 Open eDocker CREATE!
2.	 Click on Register (you will need the serial number). 

 
 
 
 
 
 
 
 
 

3.	 Enter the serial number you received with your order confirmation 
in the  
Fill in license key to register field and click Register. 
 
 
 
 
 
 
 
 
 

After this, eDocker CREATE! will open and you may use it normally. 
Remember that you can install eDocker as the admin user, but actual 
registration must be carried out when you are signed in as the user 
who will use eDocker in the future.

Deactivation

1.	 Click on the question mark icon in your screen's top right corner.
2.	 Select Deactivate License at the bottom of your screen
3.	 Confirm that you wish to deactivate your license.

1

2

3

After this, eDocker CREATE! will no longer function on this 
computer, but you may use the same serial number again 
on another work station.
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Widgets

The new CREATE! differs from previous Tablet Publishers in that there are now a lot more 
interactive widgets than before. Nearly all the program's widgets can be presented in two 
difference appearances:
• Inline, i.e. on the page, at the location/size they have been assigned.
• In a pop-up/lightbox window, the size of which can be specified.

Widget sizes
When specifying the size of widgets (inline areas, pop-up windows, opening hot spots etc.) 
the user must know whether the publisher wants the zoom function to be used in the 
publication. If the zoom function is used, the full screen size will be 1536X2008 px (ver-
tical) or 2048X1496 px (horizontal). If the zoom function is not in use the corresponding 
sizes are 768x1004px and 1024x749. In other words, if you want a popup window to open 
at full screen size you need to know if the full screen size is 768px or 1536px...

a pop-up window that is 700 
px wide a pop-up 

window that 
is 700 px 
wide

768px 1536px

1004px 2008px
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An element in Inline mode is situated on the page at the 
location and the size
• specified for the Multi State Object in InDesign
• or as defined in the TP’s X/Y/Width/Height fields

When using InDesign
go to Appearance 
Inline, location and 
size
are selected in MSO.

Uncheck ‘Open in pop-up’ box in CREATE! and 
specify the location and size in numerical for-
mat or by dragging with the mouse.

A slideshow is situated directly 
in the assigned place on the 
page

Inline mode
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Opening in a pop-up-window
The majority of widgets can also be opened in a pop-up window, and this is the recom-
mended option for most widgets. This causes less of a load on the device and browser 
video card, and random access memory than inline elements and is easier to use. 

The values given in 
CREATE!'s X/Y/Width/
Height fields determine 
where the pop-up's 
hotspot will be located. 
When the user clicks on 
the hotspot, the pop-up 
opens.

A symbol drawn on top 
of an image in InDesign 
to indicate the image is 
not just a single picture

The pop-up opens
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When using InDesign
go to Appearance 
and select Popup. The loca-
tion and size of the opening 
trigger
are selected in the MSO.

While in CREATE!, check Open in Popup and specify 
the size of the popup (width and height) in the fields 
below the checkbox.
The hotspot's size and location are specified using 
the X/Y/Width/Height fields.
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eDocker TOOLS
The InDesign portion of eDocker’s workflow has changed a great deal. In previous ver-
sions, page content was predominantly exported from InDesign to eDocker. Now, the new 
version of InDesign allows the user to carry out a great deal of other actions, e.g. adding 
interactive elements and naming articles. 

Also, a publication can no longer in exported in the wrong size. 

Article structure
As in previous versions of eDocker, the new version allows you to adjust the publication 
pages to follow the article structure. This means that the publication’s pages are not 
stacked horizontally next to one another, but that some of the pages - i.e. the pages in 
the article - can also be listed one below the other in the page matrix. Therefore, the lon-
ger the article, the more pages are listed one below the other. A short article may fit on 
just one page.

The article structure is created by further adding sections to a publication with InDesign’s 
own tool. 
1: Select the first page of the article from the Pages panel
2: Select Numbering&Sections Options from the Pages panel
3: Click OK

From this page forward the pages are always 
stacked in the matrix  
at the start of each following section

The small triangle above the icons in the Pages panel
indicates that a new section starts from that page
and is also a new article.
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NEW!
You can now already add the article’s name at this point. Type the name of your choice 
in the Section Marker field. The name will travel with the package to CREATE! and appear 
there in the Article Name field for every article and finally into the table of contents of 
the publication’s navigation panel.

PLEASE NOTE: If you intend to specify the article structure while still within InDesign, 
you must define the sections throughout for the entire publication. If you stop adding 
sections halfway through, all the starting pages for the remaining sections will be in the 
same article i.e. on top of one another.
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Hyperlinks

The new eDocker makes it possible to already create hyperlinks in InDesign, if you wish 
to do so. You may also add links in the Tablet Publisher’s page editor.

Adding hyperlinks to InDesign

1: Create the hyperlink’s activation area (hotspot) by drawing a rectangle, with no fill color 
or border, for the spot in question.
2: Use InDesign’s Window>Interactive>Buttons&Forms tool and change the rectangle to a 
Button (Type:Button)
3: Set Go to URL as the Button’s action (+ symbol)
4: Type in the URL field 
	 - a www address beginning with "http://"
	 - #a[article number]p[subpage number], e.g. #a3p5
	 - a link beginning with "mailto:", if it is a link to an email address
5: Open the Window>Extensions>eDocker-tools panel
6: Select the button you just created and move to the Hyperlink tab in the eDocker Tools 
panel
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Expandable Image

The expandable image is a tool that allows you to:
- expand a small image in a pop-up window
- create "additional information" type pop-up windows

Expanding a small image
1: Prepare the image you wish to use with the function. Make sure the image is the size 
you want using image editing software or in another InDesign document, e.g. 600 x 400 
px, and save in JPG or PNG format.
2: Import the image for publishing using the Files>Place command or a similar method
3: Select image and click on the Expandable Image tab in the eDocker Tools panel
4: Select whether you want the pop-up window to open when the image in the layout is 
clicked on (Open With: Invisible Hotspot) or generate a button to go along with the image 
(Open With: Button)
5: Add the web address where the user will end up by clicking on the image to the pop-
up window (optional)
6: Select the size of the pop-up window that will open.

PLEASE NOTE: We recom-
mend that you use the correct 
size JPG/PNG images. If you 
have selected, for example, a 
PDF or AI file, eDocker TOOLS 
will automatically attempt to 
change the file into PNG for-
mat.
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Making Info-pop-ups

Use image editing software to create additional information window content within a 
pop-up to the correct size, e.g. 600 x 400 px, and save in JPG or PNG format. You can 
also make a content image in InDesign and use InDesign’s File>Export >>> JPG or PNG 
function.

Do just as in the previous instruction, but minimize the image in the publishing program 
to a very small size, and place a button on top of the image with text such as Additional 
information or Open additional information window here 

Specify an Invisible Hotspot in the Open With section.

It is of key importance that the button covers the entire image underneath it. This way, 
only the button will be visible in the publication that is exported to CREATE! The small 
image under the button will still function as the opening button, even though the main 
image is not visible in the final layout. It will of course show up in the pop-up window 
that will then open.

•import the popup window's content into the publishing pro-
gram and minimize its size, so that it is very small

• Specify that the content image is an Expandable Image 
and specify the size of the pop-up window

•draw the button you want to be visible in the lay			 
out or move one on top of the image

A dotted line depicts the image located under the button. A 
larger version of this image will open into a pop-up window 
in the final publication.

Further in-
formation:
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Slideshow

Use the Slideshow tool in InDesign to specify a group of images that will function as an 
image carousel in the final digital publication. The image carousel can be located directly 
on the page, e.g. in place of an image (Appearance: Inline) or open in a pop-up/lightbox.

Specifying a group of images for a slideshow

1) Prepare the images so that they are the size you want in either Photoshop or in an-
other InDesign document that is correctly sized. We recommend that all the images are 
the same size, e.g. 600 x 400 px
2) Import all images to the layout by selecting File>Place in InDesign.
3) Place images on top of one another in a stack, use the Window>Object&Layout>Align 
panel tools if needed.
4) Select all the images in the stack and click the small paper icon at the bottom of the 
Window>Interactive>Object States panel. Now the image stack has been converted into a 
so called Multi State Object.
5) Select the Multi State Object and go to the eDocker Tools panel to select how you wish 
the slideshow to function in the final publication.

 Create a new Multi 
State Object from the 
selected images

 A Multi State Object 
can be recognized by 
its thick dotted line 
border.

The Appearance can be Inline 
(on the page within the lay-
out) or as a pop-up (opens into 
a new window on top of the 
page)

If you have selected 
a pop-up, it can be 
opened via the but-
ton or from on top the 
Multi State Object (In-
visible Hotspot)

Specifying the size of a 
pop-up windowPLEASE NOTE: You can set the hidden slide-

show to open from the button by minimizing 
the Multi State Object to a very small size and 
placing it behind the button graphic.
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Video

Use the video tool to move H.264 encoded MP4 video you have imported to the layout for 
the final publication and set it to 
-play inline among the layout elements (Appearance:Inline)
-open in a separate pop-up/lightbox window, when the video's poster icon is clicked
-open from the hidden video's button
You may also use e.g. Youtube or Vimeo type streaming videos, but in InDesign these are 
made with the HTML Window tool. Note that the use of streamed videos always requires 
an online connection.

Specifying a video
1) Prepare the video for use e.g. with the Adobe Media Encoder that comes with InDesign 
or other similar software. The video must be an H.264 encoded MP4 video.
2) Make the video the correct size. Don't make it too large. The size may very quickly 
prove to be too large for online use. A good width is usually approx. 400-500px.
3) Import the video to the layout with the File/Place command.
4) Specify the use of the video in the eDocker Tools / Video tab.

The Appearance can be Inline 
(on the page within the lay-
out) or as a pop-up (opens into 
a new window on top of the 
page)

If you have selected pop-up, it can be 
opened by clicking on a Button or an 
Invisible Hotspot.

Specifying the size of a 
pop-up window

PLEASE NOTE: You can set the hidden video to open 
from the button by minimizing the video to a very small 
size and placing it behind the button graphic.
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HTML Window

Use the HTML Window tool to set the rectangle to function as a place holder for the URL 
address you have specified. In the final publication the content for the place the rectangle 
is located will be imported from the given address, or the rectangle can act as a hotspot, 
so that by clicking on it a pop-up/lightbox will open and the content found from the URL 
address will play.

This function can be used to import the following into the publication
-online videos
-additional information pages from the Internet
-shopping cart windows

It is important to make sure the selected space is the size needed for playing the import-
ed content. So-called responsive content is the best functioning option as it conforms to 
the space available.

Specifying an HTML Window
1) Draw a rectangle in the part of the layout you want it in.
2) Select the rectangle and open the eDocker Tools/HTML Window tab
3) Specify Appearance
If you select Inline, the content will appear directly on the page inside the rectangle
If you select pop-up, the rectangle will become a Hotspot. The HTML Window will then 
open in a pop-up/lightbox window when the Hotspot is clicked, and the content will be 
displayed inside it.
4) Specify the URL from which the content will be imported

Rectangle

The Appearance can be Inline (on the page 
within the layout) or as a pop-up (opens into a 
new window on top of the page)

If you have selected pop-
up, it can be opened by 
clicking on a Button or an 
Invisible Hotspot.

Specifying the size of a 
pop-up window

Specifying a URL
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Article / Reading Mode

Article / Reading mode is an entirely new tool in eDocker. It can be used to specify the 
texts of your choice as so called InDesign Articles. These articles move with the publica-
tion as text documents all the way to end users, who can open each article in a pop-up/
lightbox, which opens on top of the page. This makes the text easier to read.

Texts marked with a red frame are dragged under Article 1, those 
with a green frame are dragged under Article 2.
Both articles and their content open in their own reading mode 
windows.

1) Select the text frame for Article 1.
2) Open the eDocker Tools in Article/Reading mode 
tab and specify whether the reading mode for Article 
1 will open when the text frame is clicked (Invisible 
Hotspot) or a Button will be generated for opening 
the reading mode.
3) Specify the size of the reading mode window (pop-
up window size)
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It is possible to specify whether the text's reading mode is acti-
vated by clicking Article 1's text frame (Appearance:Invisible) or by 
using a separately generated Button (Appearance:Button)

x
Vapaamatkat is a new Helsinki-based 
travel agency that offers its customers 
genuine care-free travel experiences. 
We organize holidays lasting from 1 
week to 1 month to both domestic and 
foreign locations. Our motto is "Can 
do". When you set off with us as a "free 
traveler", you will undoubtedly get a 
holiday that is relaxing, active and ac-
tion packed, as well as being safe but 

AAA
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Exporting a publication into eDocker CREATE!

When you have completed all the actions you wish in InDesign, it is time to export the 
project into eDocker CREATE!, where you can continue to work on the material.

1) Save the document, as you cannot export an unsaved project.
2) Select the Export to CREATE! tab from the eDocker Tools panel.

At this point, you may see a couple of different warnings.

You will see these notifications, if your document 
uses the CMYK transparency blendspace. Usually, 
you need not worry about these notifications, but 
if your publication contains many elements with 
transparency, you can change the blendspace with 
Edit>Transparency Blendspace

You will see this notification if your document is not 
the same shape as the iPad screen. In such cases, 
eDocker Tools forms white margins along the docu-
ment's edges, so that the shape of the page will be 
correct.



19

3) After this the actual export settings window will open, and from there you must
	 • turn the zoom function on, if you want it to be possible for users to zoom in on 
your document and see it in high definition (expand the size of the publication package)
	 • set the page image saving quality (we recommend medium or high)
	 • specify the location for your project files to be saved (this must be an empty fold-
er)

4) Finally, click Export The Tablet Exporter will now begin to create page images and to 
collect images, videos, texts, etc. related to interactive elements. 

PLEASE NOTE: Check again to make 
sure that all the page images in the 
JPG folder are 1536x2008/2048x1496 
(vertical/horizontal, zoom on) or 
768x1004/1024x748 (vertical/horizon-
tal, zoom off)

Turn zoom function on or off

Set quality

Set target folder

Click 'Export'
The Tablet Exporter writes the sub-fold-
ers for the image in question in the folder 
you have selected; the texts that are to 
be opened in reading mode are saved in 
the Articles folder, the slideshow imag-
es and expandable images in the Images 
folder and video files in the Videos folder. 
The JPG folder contains the pages and the 
Thumbnails folder for the image thumb-
nails. Content.jso contains all metadata (el-
ement sizes and locations, page structure, 
page names, etc.)
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eDocker CREATE!
Next, we will have a look at eDocker CREATE!'s new functions and uses.

The program's new workflow means that users can select the settings of their choice in 
many areas either in InDesign or in CREATE!. An element created in InDesign can also be 
altered, added to or removed in CREATE!.

Importing a project to eDocker CREATE!

This function has not significantly changed from previous versions. The import function is 
still visible at the bottom right of CREATE!'s main page (+ symbol)
If you have created a project in InDesign and saved it as an open folder-based project, 
use the import folder function, go to the folder that the Tablet Exporter InDesign plug-in 
has created and click OK.

If you have used the eDocker PDF2TABLET converter or the Package function in the 
Tablet Exporter InDesign plug-in, use the Import Archive function and go to the project's 
EDTP file (some operating systems carry out the Import Archive action automatically at 
the end of conversion/export)
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After successful import, a miniature icon of the publication's first page will be generated 
on CREATE!'s main page. You can enter the publication mode by double-clicking the icon; 
this function works exactly as it has in previous versions of CREATE!.

Any page within the publication can be opened in publication mode by dou-
ble-clicking on the icon for the page in question on the light table (not the 
thumbnail panel)
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Click on the article  
to activate it; the blue border 
indicates that the article has 
been selected

The symbol indicates that 
interactive indicators have been 
used 
on the page

Video

Hyperlink

HTML window

Slideshow

pop-up image

Scrolling content

Miniature images

Hide miniature images

Return to library view Remove article
Add new page to article
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Drag pages, if you wish to 
change their order.

Change article name (click 
on pen)

Help

Change the miniature 
image on the page

Article name. Names can be viewed in 
the publication's navigation panel.

Article description

Preview Publish

Add Remove pages
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Adding hyperlinks

This function has remained nearly the same as in previous versions. A new feature is 
that users can specify the size and location of a hyperlink's Hotspot area already during 
the creation phase, while previously the project had to be created first and the user edit-
ed the work after which the X/Y/Width/Height fields were activated.

All the added elements can be 
moved and scaled with your 
mouse just as in previous ver-
sions.

To return to the edit space place 
the mouse cursor on top of an el-
ement and click the pen icon that 
appears...

Remove an element with the x in 
the same space.

Edit 	 Remove

You can use the 
"#article_number" 
and "mailto:e-mail 
address" type links 
as well
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Adding images

You can use the image function to add the following to the publication 
• a hidden image that the end user can open by clicking on the specified hotspot or but-
ton
• an image on the page, if the image is larger than the space assigned for it, you can use 
a scrollable image in the area (this is not possible yet, and currently the image is scaled 
down to fit in the designated area)

1) Find the image you want in the Search Image section. If you want to open the image in 
a pop-up window size it correctly.
2) Add an address to the Link section, if you want the user to be able to open a certain 
webpage by clicking on the image (does not work yet in this version) Click Save.

TIP!
You can draw an I-button, for 
example, into the layout in InDe-
sign and then add an image in 
CREATE!, set it to open in a pop-
up window and draw an invisible 
hotspot on top of the I-button.

TIP! If you place an inline image 
in a space that is smaller than 
the image, it will automatically 
become a scrollable image

Title - only visible in CRE-
ATE!

Link (optional) - add the link to 
the page that will show up when 
clicking on the image

Preview Size & location Open in pop-up window 
If this is on, the user 
can specify the size of 
the window in the field 
below the cross. 

If the Open in pop-up 
window checkbox is not 
checked, the element 
will be placed direct-
ly on the page inline 
according to the X/Y/
Width/Height values for 
its location and size.

Image - browse for 
an image file

If the Trigger Icon section is 
left empty, the area defined 
with X/Y//Width/Height val-
ues will function as an invisible 
hotspot, and by clicking on 
this the pop-up will open. If a 
button has been placed here, 
the button will function as the 
opening trigger.
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Adding a slideshow

The slideshow tool allows you to add a slideshow consisting of 2 or more images to a 
page of your publication. The slideshow can be directly on the page or set to open in a 
pop-up window (Add or remove the x next to 'Open in pop-up')
The end user will see the first image of the slideshow, while the other images can be 
made visible with the mouse or a swipe of the finger if you are on a tablet.

Adding a slideshow
1) Click on 'Add New Slideshow' and give the slideshow a name, enter the size and loca-
tion information, then click Save. You may specify at this point whether the slideshow will 
open in a pop-up window or be played directly on the page in the location of your choice.
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2) Scale the gray square that appears on the page to the size and location of your choice.
3) Click on the small pen icon, which will appear when you place the mouse cursor on top 
of the gray rectangle. 
4) Browse through the images in the slideshow one by one. We recommend that you pre-
pare the images to be included in the slideshow in the correct size in Photoshop, for ex-
ample, before importing them.
5) Finally, click on Save

TIP!
You can draw a 'view images here' button, 
into the layout with InDesign, add a slide-
show in CREATE!, set it to open in a pop-up 
and draw an invisible hotspot on top of the 
View images here button.

PLEASE NOTE:
If you have already added a slideshow in 
InDesign, it will now show up on the page 
in the same way it would had you made it 
in CREATE!. You can edit a slideshow you 
have created in InDesign, whilst in CREATE! 
or remove it.
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Adding a video

Earlier versions of CREATE! have had the option of adding an MP4 video to a publication 
page. In this new version, the function has been developed and it is now better and more 
sophisticated. New features allow you to
• open a video in a pop-up window that is equipped with a close-button.
• place a video directly on the page, so it can be viewed at the spot it was placed in.
• use videos other than MP4 videos, such as YouTube videos

1) Click on Add New Video
2) Browse to the H.264 encoded MP4 video file (Local video checked) on your hard-drive 
or provide the link to a YouTube video (Local video unchecked)
3) Specify whether the video will open in a pop-up window or play directly at its place on 
the page

If Local Video File has been selected, an H.264 encoded MP4 video must 
be entered into the Video field. Prepare the video in the correct size with 
encoding software such as Adobe Media Encoder included with InDesign. 
The recommended width for a video is approx. 400-500 px.

PLEASE NOTE:
If you remove the x from Local Video File, the 
Video field will change to a URL field. In this 
field you can enter the URL for a YouTube 
video. The URL MUST be formatted as http://
www.youtube.com/embed/videoID e.g. www.
youtube.com/embed/x_3VIdrRQVI. 

PLEASE NOTE:
Remember that YouTube videos do not 
work for users who do not have a live 
Internet connection while reading the 
publication!
MP4 videos also function while the user 
is offline, if the publication has been 
published in the eDocker Library and is 
read with the eDocker Reader.
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Adding an HTML window

Previous CREATE! versions have allowed you to add iFrame windows to the page. In 
these you have been able to present local HTML files or retrieve content from a URL ad-
dress. In this new version, the function has been developed and it is now better and more 
sophisticated. New aspects include, the ability to open selected content in a pop-up win-
dow that is equipped with a close-button

1) Click on Add New HTML Content
2) Write a URL in the Link field, from where the content will be retrieved OR browse for 
zipped local HTML material via the Local content field (index.html must exist in the zip 
archive's root) These two are alternatives to one another.
3) You can also specify a Fallback image, which is shown in place of the URL if the user 
does not have an Internet connection.

Otherwise (size, location, opening pop-up window, etc.) this functions the same way as 
previous elements.

PLEASE NOTE:
Always carefully check to ensure that the content 
you have chosen fits into the size of your HTML 
window. So-called responsive HTML files are the 
best functioning option as they can be shown in 
different size environments. 
The HTML window often uses a mobile version of 
the page in these cases.

Use one or the other.
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Adding scrolling content

An entirely new feature in the software is the option of specifying a square within the 
layout or a hidden window that contains text in the reading mode. This means:
• the text is actual text, not an image.
• if there is more text than can fit into the visible space it will be scrollable.
• in a pop-up, the user can also expand/minimize the font and the text will scroll through 
the available space according to what font size is in use.
• the text can be formatted with HTML tags
• images can also be added amongst the text using HTML tags.

1) Select Add New Scrolling Content
2) Write or copy/paste text in the text field (an option to import from files is in the works)
3) The text will be visible in the Verdana font (not bold or italics)... If you wish to add e.g. 
headers, use the h1-h3 tags as shown in the image (a small tool is being designed for 
formatting text)

If the 'Open in pop-up' checkbox is 
checked, the text will open in the size 
you want in a pop-up window, where 
the close-button and font size can be 
adjusted. 
The values in the X/Y/Width/Height 
fields will determine the place and size 
of the opening trigger.

If the checkbox is unchecked, the text 
will be placed directly on the page in a 
rectangle specified by the X/Y/Width/
Height fields.

Tip!
With 'Open in pop-up' during layout you can, 
for example, draw a symbol for the text read-
ing mode on the page and place the gray 
box depicting the opening hotspot (invisible 
to end users) on top of the element. In this 
case, the user can open the pop-up by click-
ing the spot in question.
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Adding HTML code segments to the page

Small HTML code segments can be generated from many services, such as social media.
These code segments can be used to add a Like or Share button, conversation feeds and 
other content to a webpage. These same segments can also be added to eDocker CRE-
ATE! project pages by using the Scrolling Text tool in Inline mode (Open in pop-up must 
be turned off)

1) Copy the HTML segment of your choice to the clipboard
2) Select Add New Scrolling Content.
3) Paste the code segment that you copied in section 1 to the text field.
4) Click on Open in pop-up, so that it turns of and click OK.
5) Drag the gray placeholder box to the spot and make it the size of the space you want 
the HTML segment to be executed in.

PLEASE NOTE: This function is still at beta stage, and will not function 
with all HTML. Please test carefully.

PLEASE NOTE: If there are references to a URL address in the HTML 
code, the user will need to have an online connection for the content 
to function.
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Previewing a project

There are two icons at the bottom of the Issues view:

									         Preview	 Publishing

The preview function allows the user to view the publication and its functionality before it 
is published.
PLEASE NOTE: For reasons related to information security and other limitations videos 
cannot be viewed in the preview function. If you wish to preview a video on your comput-
er before exporting it to the server, publish the project on your hard drive and open the 
project's index.html file in your browser. We recommend that you use the Chrome browser 
for local testing, as it has the fewest limitations.

In this example we will preview the reading mode window attached to one page of the 
publication.



33

Publishing a project

When all the pieces are in place, all that remains is to publish the project. To publish a 
project, look for the icon in the bottom right corner of the Issue view. Click the icon and 
the CREATE! Publish window will open.  CREATE! offers two different ways of publishing a 
project
	 • as a web publication; one for users of PCs and laptops (desktop) and one for iPad 	
	 users.
	 • The eDocker PUBLISH! service, where publications can be made available for a 	
	 fee, completely privately or subscription only.
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Exporting a web publication to your desktop

eDocker CREATE! will save the web publication as an open file package.

This package must be moved to a webserver with an FTP client. When the package is on 
the server, a URL address will be automatically created for it. Everyone who has knowl-
edge of this address can read the publication on the webserver.

The address can be shared via email or social media.

If the eDocker PUBLISH! service is also selected in the eDocker CREATE! Publish window, 
CREATE! will also produce the publication as an edtp file. This file can be published in the 
eDocker PUBLISH! service. The final user will see publications that have been imported 
into the service in the eDocker READ! environment or in the READ! mobile application.


